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Introduction

My favorite word processor of all time has always been 
WordPerfect.  I started using it with version 4.1 when it 
was really small and fast.  Now version 6.0 is here.  It is 
much bigger and somewhat slower on 286 machines, but what 
power!

When I had heard that WP was working on this product, I 
became concerned about the possible ramifications for blind 
users.  I contacted them and they put me on their beta team.

My first impression of the product was fear.  I had become 
accustomed to the look and feel of WordPerfect.  I loved 
those full screen menus, those menu driven help screens, and
the nice prompts for deleting blocks of text at the bottom 
of the screen.  Those are no longer here.  The product looks
and feels much different for a blind user.  The character 
mode they talk about when you call is much different than 
the old 5.0/5.1 interface. 

    Even so, I think that WordPerfect 6.00 is much better for    
speech and braille.  Good going WordPerfect Corporation!

This sent me on a mission to conquer the great WP 6.0!  This
document along with the keyboard files provided is the 
partial answer to my mission.

This document is intended for those with good experience in 
configuring applications.  It is not meant to be a guided 
tour on how to configure WordPerfect 6.0.  Consult the 
vendor of your access technology to see if they have 
developed a configuration for WordPerfect 6 yet.  If not, 
send this package to them to assist them in developing that 
configuration.  Every little bit helps in this industry.
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Legal Stuff

WordPerfect is a trademark of WordPerfect corporation.

Jaws (Job Access with Speech) is a trademark of Henter-
Joice.

ARTIC business Vision is a trademark of Artic Technologies.

Vocal-Eyes is a trademark of GW Micro.

I have spent a great deal of time developing this keyboard 
definition file. This product will be continually upgraded. 
It is my intent to provide a new interface than the current 
design that WordPerfect has implemented.  I will be 
tailoring the interface specifically for braille and speech 
users.  I am not saying that the default interface is bad, 
but some minor changes can make it even better for speech 
and braille.  All of this will be done with the power and 
flexibility of the WordPerfect macro language.

If you continue to use this product after 30 days a 
registration fee of 12 dollars is required.  Registrations 
will be used to defray the cost of distributing the product 
on electronic bulletin boards and other means.  Once you 
registration, a diskette with the latest version of WP BASIK
will be sent to you.  The shareware messages will be removed
as well.

If you are an access technology vendor, and you would like 
to incorporate this keyboard file into your product, please 
contact me.  I have no problems with this but would 
appreciate it if you would mention how this was obtained in 
your documentation.  You must also mention the fact that 
this is shareware and that if the customer is to continue to
use it, he/she must register it.  Please contact me as new 
versions will be made quickly.  I would also like to discuss
how you will implement this in your application.

I will be keeping a list of vendors who have incorporated 
this keyboard file into their product.  Any configurations 
that have been developed for your screen reader would be 
helpful if you would be willing to pass them along.  I will 
maintain a library of these configurations.  I would like to
include them in this package so users have instant access to
the configuration files.
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What did I Find?

1. The menus
One of the greatest changes in WP 6.0 is its new menus.
Overall, the new menus place the system cursor on the 
highlighted menu mnemonic letter, making it even easier
to use than 5.1 was.  The only problem is that the 
document stays on the screen surrounding the menu 
itself.  Now you will hear parts of the document if you
read the whole line while on a menu item!

2. Deleting of Codes
One of the nicest things about 5.1 was that when you 
deleted a code from a document, you got a prompt at the
bottom of the screen asking if you really wanted to do 
that (assuming reveal codes was not on).  WordPerfect 
now pops up a dialog window asking you the same 
question.  This presents a little more of a challenge 
for configuring this little window to speak 
automatically.  Most screen readers will make this a 
piece of cake, but others that are not as advanced will
make it difficult to configure.

3. The help system
I love online help.  I feel that every computer product
should have it and it should work really well.  
WordPerfect changed their help system to a hypertext 
help system.  You will now have to point at items with 
a cursor key and press <ENTER> on them to get them to 
come up.  This will be the most difficult challenge in 
configuring WordPerfect 6.0.  If you configure your 
speech system to track a menu bar while in help, you 
will make it work.  the only problem in using help is 
when you use the up/down arrow and scroll the help 
window.  If your screen reader will allow you to 
monitor portions of the screen and only speak those 
areas that change, you are in luck.  Most newer 
versions of adaptive screen reading technology have 
this ability.

4. Crowding up the Dialog Menu
With the release of WordPerfect 6.0, WordPerfect has 
introduced new text dialog menus.  I love them, BUT!  
There are a few that have more than one column of 
choices.  This means, if you read the current line, you
will hear two menu choices.  If you are not careful, 
you will not know which one you are on.  With some 
careful learning, this should not be a problem.

5. Inconsistent Dialogs
I found that one of the Dialogs does not allow the 
screen to be cleared when it pops up.  The dialog in 
question is the control-F4 key (the move dialog).  For 
this reason, this dialog will be a little more 



4
The WordPerfect Braille and speech Interface Keyboard

Version 1.2
August 1, 1993

difficult to configure.
6. Some pick list boxes in WordPerfect do not track (move 
the system cursor with the highlight bar).  Most of these 
windows have the ability of performing a "NAME SEARCH" 
function.  The cursor is placed in a small box where text 
can be entered for the "NAME SEARCH" function.  A macro can 
not get around this one.
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What Did I Conquer?

Since many of us use different screen reading packages, I 
thought it would be best to attack a great deal of the 
challenge in configuring WordPerfect 6.0 with WordPerfect's 
own macro language.  For this reason, I have developed a 
WordPerfect keyboard file for WP 6.0 that hopefully will 
assist in making WordPerfect 6.0 better for all when setting
up configurations.  The rest of this document describes this
keyboard file and the way that it should be used when 
configuring WP 6.0.

What files are included in this package?

The following files are included in this package:

File Name Description

DESC.SDI and
FILE_ID.DIZ These two files are short descriptions of 
this product.  These files are used by electronic bulletin 
board services to automatically provide a file description 
of this product.
WPB.WP This documentation in WordPerfect 6.0 format.
READ.ME This documentation in ASCII text.
WPBSTART.WPM This is the startup macro that is used to 
setup specific options necessary for optimum use with the 
new keyboard file.  This macro turns off the pull-down menus
from displaying by default and sets the measurements to 
inches (using the letter I).
WPBASIK.WPK this is the main keyboard macro file that 
contains the special macros for WordPerfect 6.0.
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Preparing for the Installation of the Keyboard File

It is time to install the keyboard file.  Before you can do 
this some things need to be setup first.

Copying the files

Included in this distribution archive is a WordPerfect macro
file called WPBSTART.WPM.  This macro should be placed in 
the directory that you specified during the installation of 
WordPerfect for macro files.  This is normally C:\WP60\
MACROS.

The distribution archive also contains the actual keyboard 
file.  The name of this file is "WPBASIK.WPK".  This file 
should also be copied to the same directory the macro was.

Setting the WP Environment Variable

The first thing you need to do is to set an environment 
variable in your AUTOEXEC.BAT file.  Put a line in your 
AUTOEXEC.BAT file that reads:

SET WP=/m-wpbstart /ND

The /m switch tells WordPerfect to invoke the WPBSTART macro
upon entering WordPerfect.  This macro MUST be run.  The 
keyboard file will not work without it.

The /nd switch will prevent WordPerfect from locking your 
system when you are using access technology.

Make sure you re-run your AUTOEXEC.BAT file, or reboot your 
system before invoking WordPerfect.  This is necessary to 
make the changes apply that you just implemented in your 
AUTOEXEC.BAT file.
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What Does the Startup Macro Do?

When you enter WordPerfect, the macro file called WPBSTART 
will execute (assuming you set up your AUTOEXEC.BAT file as 
described above).  This is what the macro will do:

1. the macro defines a special variable called WAIT_TIME 
that is used to set the length of time that the macro waits 
when displaying a prompt before it is removed.  The variable
is assigned a value of 10.  This means 1 second.  Depending 
on your system, you can change this value to a lower number.
Experimentation is required to determine the best parameter 
to use for speech responsiveness.

2. The new WordPerfect Braille and Speech Interface 
Keyboard file is made the default keyboard for this session 
of WordPerfect only.

3. The entry and display of measurements have been set to 
inches (I was used in this case).  This, I have found, is 
the best setup for speech users as measurements are spoken 
better.  The old style of WordPerfect 4.2 unit measurements 
is no longer available.

4. The pull-down menus are no longer visible on the main 
document screen.  This was done for easier reading of the 
document.

5. Beeps are turned on for all conditions available in 
setup for the current session only.

6. A message informing you that WordPerfect is ready for 
use is displayed on the status line.
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Configuring the Status Line

For this keyboard file to work correctly, you will need to 
configure two windows for the status line.  Follow these 
guidelines:

1. For the first window, the area of the screen should be 
line 25, columns 1 through 48.  DO NOT go beyond column 48.

2. Configure the screen reader to trigger on a caret 
symbol (^) in column 1.  When this is seen, this window 
should speak.  Many messages presented in this keyboard file
begin with a caret symbol (^).  I have found that 
information, other than that provided in the keyboard that 
is shown on the status line, is really not that useful (with
the exception of the positioning information on the right 
side of the status line) and the filename/font name on the 
left side of the status line.

3. Configure a second window for the full length of the 
25th line of the screen.

4. This window should only speak when the string "**" 
appears.  This string will start in column 1.  The full line
should then speak.  This is the string that is used to 
signify that a menu is appearing on the bottom line of the 
screen.

5. A third window should be setup to monitor the status 
line.  Search for the string "Selection:" starting in column
1 of line 25.  If this is seen, read the whole screen.  this
represents a vertical menu like the old WordPerfect 5.0/5.1 
menus.

Other tips and techniques will be added to this section as I
receive feedback from you, the user.
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What does this keyboard file provide?

This special keyboard file provides prompts on the status 
line for all Dialogs that can be invoked by the use of 
function keys and other keyboard commands.  

When configuring your screen reader for this keyboard file, 
look for a caret (^) followed by any text.  Each special 
prompt will begin with the caret (^).  This distinguishes 
other WordPerfect prompts that might appear.  In my 
experience, no other prompts or information shown on the 
left side of the status line is of any value (with the 
exception of the filename and the current font of the 
document).  All special prompts/messages will remain in 
columns 1 through 49 of the status line.  Keep this in mind 
when configuring your access technology.

When a dialog comes up, you will be told by a message on the
status line.  When you have completed your activity in that 
dialog, you will be told when you have returned to the main 
editing screen.  I added this simply because it can be 
difficult to tell when WordPerfect reacts to a key.  The new
version 6.0 can be sluggish on some systems.  Be patient, it
will communicate with you eventually.  I say this only to 
make sure that if you are running on a 286 system, that 
responsiveness might be redefined from your experience with 
WordPerfect 5.1 or earlier.

Other techniques have been implemented in this keyboard file
to assist in screen reading technology configuration.  Refer
to the chart on the following pages for further information 
on what techniques have been made to assist you.  Each 
redefined key is described in detail.  The keys are listed 
in groupings.  In some instances multiple keys are listed 
together when the same function applies to a set of keys 
that has been redefined.

The following charts show each key that is defined in the 
keyboard file and how it has changed from the WP default.  
If you do not like the way this key functions with the use 
of this keyboard file, delete that keyboard definition from 
the keyboard layout in setup (shift-F1, keyboard, edit).
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CHART 1 Normal function Key Layout

This chart shows the basic normal function key layout.  Some
additional keys are also shown that apply with the key being
explained.  For example, the CONTROL-B key is described 
along with the F6 key since they perform the same function.

Key Meaning Description

F1 HELP This key clears the current document from the 
screen and brings up the help screen for the current area.  A 
message is also displayed beginning with a caret symbol (^) 
informing you that the help screen has been invoked.
F2 Search This key clears the current document from the 
screen and pops up the search dialog (the normal function for 
this key).  You are notified of this with a message on the status
line.  Once the search completes, you will be notified that you 
have returned to the editing screen.  The prompt will tell you to
"enter a string to search for".
F3 Switch This key allows you to switch to any document you 
wish.  WordPerfect supports up to 9 documents open at any given 
time.  When you hit this key, a prompt will be shown on the 
screen asking you which document you would like to switch to.  
This is different from the standard function of WordPerfect.  In 
WordPerfect, a dialog window is opened displaying a list of all 9
documents (whether or not 9 are open).  The number of the 
document along with its filename is displayed in the dialog.  I 
felt that this information was fine if you really need it, but 
for speech users I thought a simple prompt would be better and 
faster.  For this reason I re-defined the key to show a simple 
prompt instead of the dialog window.  When you enter a number, 
WordPerfect will let you know on the status line which document 
is being opened.  This makes it nice if you accidentally hit the 
wrong document number.
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CHART 1 (CONTINUED)

Key Meaning Description

F4 Indent
SHIFT-
F4 LR INDENT
TAB TAB
Shift-
TAB BackTAB
CONTROL-
F6 Decimal

Tab
ALT-
F6 Flush Right
SHIFT-
F6 Center These seven keys move the cursor through the 
document by their respective functions.  When these keys are hit,
the new position will be shown on the status line (surrounded by 
caret symbols).  This allows for easier editing in multi-columns 
and when aligning up text in paragraphs.
F5 List

Files This key will clear the screen and invoke the list
files screen.  A message on the status line will inform you 
of your entrance into and out of this function.

F6 Bold and
F8 Underline These two keys will inform you of the state of the
bold and underline functions.  You will know when bold is on, 
when bold is off, and when a blocked area is bolded.  This also 
holds true with the underline key.  These messages are displayed 
on the status line and are surrounded by caret symbols (^).  The 
control-B (bold) and control-U (underline) keys provide the same 
functionality as F6 and F8 do.
F7 Exit This key will perform the same function as its 
default key in WordPerfect 6.00 While in the editing screen if 
you press F7 you will be told what to do next.  The prompt will 
inform you that you can "Save As, Yes, No, Cancel (S, Y, N, or 
C)".  These are the choices that are shown in the default dialog 
that is invoked.  The dialog is invoked and is ready for your 
response.
F10 Save This key will clear the screen and invoke the 
"Save Document" dialog.  A message on the status line will inform
you of your entrance into and out of this function.
F11 Reveal

Codes This key toggles reveal codes on and off.  this 
key is the same as ALT-F3.  You are told when Reveal Codes 
is on and when it is off.

F12 Block This key toggles the block feature on and off.  
You are told when block is on and when it is off.
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CHART 2 Shifted function Key Layout

The keys in the chart below are those function keys accessed
by pressing the SHIFT key (SHIFT-F1 through SHIFT-F12).  For
this reason, the shift key will not be shown in the KEY 
column when the keys are listed.

Key Meaning Description

F1 Setup This key will invoke an old WordPerfect 5.1 look-
a-like setup menu.  You are presented with the setup menu in a 
full screen with the word "Selection:" on the status line.  You 
can select the options either by pressing the number on the left 
of each option, or the first letter of each menu choice.  When 
the letter/number is pressed, you are taken to that dialog.  When
you complete this dialog you are returned to the main editing 
window.  Unlike the standard setup key, I had to take you back to
the editing window due to a "CHAR" macro command problem I have 
not been able to code around.  This will hopefully change in the 
next release.
F2 Reverse

Search This key invokes the search function (in reverse).
The screen is cleared and a message is placed on the status 
line.  When Search is completed, a message letting you know 
that you are in the document screen is displayed.

F3 Switch This key invokes the Switch document function.  
This key switches between the last two windows opened.  When you 
switch to a different document, that document number is displayed
in a message on the status line.  This is done so that you always
know which document is currently being edited.
F4 LR Indent Refer to chart 1 for a description of the indent 
and LR Indent functions.  This key is grouped along with others 
that perform the same function.  Look for the "F4" key in this 
chart for the five key grouping.
F5 Date This key invokes the "DATE DIALOG".  This key 
varies from the WordPerfect default.  A simple horizontal menu is
shown on the status line beginning with the character sequence 
"**".  All functionality is maintained, but it is easier to deal 
with than the dialog default.  Once you have used this menu, you 
will be told when you return to the document after exiting this 
function.  To exit this menu press either F7 or the <ESCAPE> key.
F6 Center Refer to CHART 1. for details on this key.
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CHART 2 (CONTINUED)

Key Meaning Description

F7 Print This key invokes the "PRINT DIALOG".  The screen 
is cleared and a message is displayed on the status line telling 
you that the dialog is being invoked.  A message after the dialog
is closed is also displayed.
F8 Format This key will invoke an old WordPerfect 5.1 look-
a-like format menu.  You are presented with the format menu in a 
full screen with the word "Selection:" on the status line.  You 
can select the options either by pressing the number on the left 
of each option, or the mnemonic letter of each menu choice.  When
the letter/number is pressed, you are taken to that dialog.  When
you complete this dialog you are returned to the main editing 
window.  Unlike the standard setup key, I had to take you back to
the editing window due to a "CHAR" macro command problem I have 
not been able to code around.  This will hopefully change in the 
next release.
F9 Merge

Codes This key invokes the "MERGE CODES DIALOG".  The 
screen is cleared and a message is displayed on the status 
line telling you that the dialog is being invoked.  A 
message after the dialog is closed is also displayed.

F10 Retrieve This key differs from the standard WordPerfect 
function.  This key will invoke the "RETRIEVE DIALOG" instead of 
the "OPEN FILE DIALOG".  This key now acts similar to the way 
that 5.1 did in that you can retrieve a document into the current
one being edited.  The standard 6.0 key opens a new document when
the file is loaded.  The screen is cleared and the dialog is 
presented.  A message is placed on the status line informing you 
of the dialog being invoked.  You are also notified when the 
dialog is closed.
F11 Redline This key has been written to assist in redlining 
documents.  This key acts very similar to the bold key.  You are 
notified when redlining is on, off, and when text that is blocked
is redlined.

F12 Strikeout This key has been written to assist in striking 
out document text.  This key acts very similar to the bold key.  
You are notified when strike out is on, off, and when text that 
is blocked is striked out.
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CHART 3 Control Function Key Layout

The keys in the chart below are those function keys accessed
by pressing the CONTROL key (CONTROL-F1 through CONTROL-
F12).  For this reason, the control key will not be shown in
the KEY column when the keys are listed.

Key Meaning Description

F1 Shell I have re-defined this key to show the shell menu 
in a vertical style menu.  The only draw back to this key is that
if you are running WordPerfect 6 from the SHELL 4.00 program that
comes with WordPerfect 6, you will not have two of the options.  
You basically will not be able to list the current running 
programs and switch to them.  Sorry about that.  When I can 
figure out how to find out that the shell is running under 
WordPerfect, this will change.  Select each option either by its 
number or the first letter of the menu item itself.
F2 Speller This key has been re-defined somewhat from the 
standard WordPerfect 6 default.  This key invokes a new menu that
looks very similar to the WordPerfect 5.1 menu structure.  A full
screen menu is displayed showing each option that is available.  
No options have been eliminated from the feature of this key.  If
you wish to exit this menu, press the <ESCAPE> key.  the F7 key 
will  exit from the menu.  The standard speller dialog allows you
to invoke Speller Setup by pressing the SHIFT-F1 key.  This is 
possible in this new menu as well.  Simply press "S" or the 
"SHIFT-F1" key to invoke Speller Setup.
F3 Screen This key invokes the "SCREEN DIALOG".  The screen 
is cleared and a message is displayed on the status line telling 
you that the dialog is being invoked.  A message after the dialog
is closed is also displayed.
F4 Move This key invokes the "MOVE DIALOG".  The screen is
NOT cleared when this key is used.  I am not sure why this does 
not work, and neither is WordPerfect.  Both WordPerfect and I 
guess that it does not clear it so that you can see what has been
blocked (that is a wild guess).  A message is displayed on the 
status line telling you that the dialog is being invoked.  A 
message after the dialog is closed is displayed.
F5 Outline This key invokes the "OUTLINE DIALOG".  The screen
is cleared and a message is displayed on the status line telling 
you that the dialog is being invoked.  A message after the dialog
is closed is also displayed.
F6 DEC TAB Refer to CHART 1 for information on this key.
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CHART 3 (CONTINUED)

Key Meaning Description

F7 Notes This key invokes the "NOTES DIALOG".  The screen 
is cleared and a message is displayed on the status line telling 
you that the dialog is being invoked.  A message after the dialog
is closed is also displayed.
F8 Font This key invokes the "FONT DIALOG".  The screen is
cleared and a message is displayed on the status line telling you
that the dialog is being invoked.  A message after the dialog is 
closed is also displayed.
F9 Merge

/Sort This key invokes the Merge/Sort menu.  Instead of 
WordPerfect invoking a dialog with two options in it, I re-
wrote the key to simply show a small menu on the bottom of 
the screen.  this will allow for easy triggering and makes 
life easier for speech users.  After selecting a choice, 
that dialog is invoked.  After completing this function, you
will be informed when you have returned to the main document
screen.  If you want to exit the menu, press either F7 or 
the <ESCAPE> key.

F10 Record This key invokes the "MACRO RECORD DIALOG".  The 
screen is cleared and a message is displayed on the status line 
telling you that the dialog is being invoked.  A message after 
the dialog is closed is also displayed.
F11 Very

Large This key sets the VERY LARGE attribute on text.  
You will be told when VERY LARGE is on, off, or when a 
blocked area of text is enlarged.  This key acts like the 
BOLD key.

F12 Italics Refer to CHART 6 key I for more information.
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CHART 4 Alt Function Key Layout

The keys in the chart below are those function keys accessed
by pressing the ALT key (ALT-F1 through ALT-F12).  For this 
reason, the ALT key will not be shown in the KEY column when
the keys are listed.

Key Meaning Description

F1 Writing
Tools This key invokes the "WRITING TOOLS menu".  This 
key has been re-defined to show a menu on the bottom of the 
screen.  This menu provides all functionality that the 
dialog provides.  Make your choice and that function is 
performed.  This menu, like all others, begins with the 
character sequence "**: signifying that it is a menu.

F2 Search and
Replace This key invokes the "SEARCH AND REPLACE DIALOG". 
The screen is cleared and a message is displayed on the 
status line telling you that the dialog is being invoked.  A
message after the dialog is closed is also displayed.

F3 Reveal
Codes This key turns REVEAL CODES ON and OFF.  A message
on the status line will inform you of the current state of 
REVEAL CODES when the key is pressed.

F4 Block
ON/OFF This key turns BLOCK ON and OFF.  A message on the
status line will inform you of the current state of BLOCK 
when the key is pressed. ON/OFF

F5 Mark This key invokes the "MARK DIALOG".  The screen is
cleared and a message is displayed on the status line telling you
that the dialog is being invoked.  A message after the dialog is 
closed is also displayed.
F6 Flush

Right Refer to CHART 1 for more information on this key.
F7 Columns/

Tables This key invokes the "COLUMNS/TABLES DIALOG".  The
screen is cleared and a message is displayed on the status 
line telling you that the dialog is being invoked.  A 
message after the dialog is closed is also displayed.

F8 Styles This key invokes the "STYLES DIALOG".  The screen 
is cleared and a message is displayed on the status line telling 
you that the dialog is being invoked.  A message after the dialog
is closed is also displayed.
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CHART 4 (CONTINUED)

Key Meaning Description

F9 Graphics This key invokes the "GRAPHICS DIALOG".  The 
screen is cleared and a message is displayed on the status line 
telling you that the dialog is being invoked.  A message after 
the dialog is closed is also displayed.
F10 Run Macro This key invokes the "EXECUTE MACRO DIALOG".  The 
screen is cleared and a message is displayed on the status line 
telling you that the dialog is being invoked.  A message after 
the dialog is closed is also displayed.
F11 Large This key sets the LARGE attribute on text.  You 
will be told when LARGE is on, off, or when a blocked area of 
text is enlarged.  This key acts very much like the BOLD key.
F12 Justify This key is a very nicely written version of the 
old "JUSTIFICATION" prompt that WP 5.1 had.  You are presented 
with a small menu on the bottom of the screen with choices from 
which to select. The title of the menu begins with the characters
"**", signifying that it is a status line menu.  You can exit 
this menu by either pressing the F7 key or the <ESCAPE> key.
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CHART 5 Pull-Down Key Layout

Key Meaning Description

ALT-= Pull-down
Menus The ALT-= (alt equals) key sequence brings up
the WordPerfect pull-down menu system.  The screen is 
cleared and the menus are invoked.  A message is displayed 
informing you of the menus being invoked.

ALT-F File This key sequence invokes the file pull-down 
menu.  The screen is cleared and a message informing you of your 
entrance into this menu is given on the status line.  When you 
leave the menu, a message informing you that you have entered the
editing screen once again (if this is true).
ALT-E Edit This key sequence invokes the Edit pull-down 
menu.  The screen is cleared and a message informing you of your 
entrance into this menu is given on the status line.  When you 
leave the menu, a message informing you that you have entered the
editing screen once again.
ALT-V View This key sequence invokes the View pull-down 
menu.  The screen is cleared and a message informing you of your 
entrance into this menu is given on the status line.  When you 
leave the menu, a message informing you that you have entered the
editing screen once again.
ALT-L Layout This key sequence invokes the Layout pull-
down menu.  The screen is cleared and a message informing you of 
your entrance into this menu is given on the status line.  When 
you leave the menu, a message informing you that you have entered
the editing screen once again.
ALT-T Tools This key sequence invokes the Tools pull-down
menu.  The screen is cleared and a message informing you of your 
entrance into this menu is given on the status line.  When you 
leave the menu, a message informing you that you have entered the
editing screen once again.
ALT-O Font This key sequence invokes the Font pull-down 
menu.  The screen is cleared and a message informing you of your 
entrance into this menu is given on the status line.  When you 
leave the menu, a message informing you that you have entered the
editing screen once again.
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CHART 5 (CONTINUED)

Key Meaning Description

ALT-G Graphics This key sequence invokes the Graphics pull-
down menu.  The screen is cleared and a message informing you of 
your entrance into this menu is given on the status line.  When 
you leave the menu, a message informing you that you have entered
the editing screen once again.
ALT-W Window This key sequence invokes the Window pull-
down menu.  The screen is cleared and a message informing you of 
your entrance into this menu is given on the status line.  When 
you leave the menu, a message informing you that you have entered
the editing screen once again.
ALT-H Help This key sequence invokes the Help pull-down 
menu.  The screen is cleared and a message informing you of your 
entrance into this menu is given on the status line.  When you 
leave the menu, a message informing you that you have entered the
editing screen once again.
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CHART 6 Shortcut Keys

The following keys are those keys to which WordPerfect 
refers to as the "Shortcut Keys".  All of these keys are 
accessed by the use of the control key (CONTROL-A through 
CONTROL-Z).  For this reason, the control key is not listed 
in the KEY column.

Key Meaning Description

A Compose This key invokes WordPerfect's "Compose" feature. 
The screen is cleared and the dialog is invoked.  A message on 
the status line is shown telling you that you have entered the 
dialog.  When you leave, you will be told when you have returned 
to the editing screen.
B Bold This key is the equivalent of pressing the F6 key.
Refer to chart 1 for more information.
C Copy This key copies the current block to the buffer.  
When the copy is complete you will be told that the text has been
moved into the buffer.
D Record This key invokes WordPerfect's "Record a Sound 
Clip" feature.  You are told when you have entered the dialog and
when you have exited to the document screen.  The screen is 
cleared for easy reading.
F Find Mark This key will jump to the "quick mark" that is set
using control-Q.  When the jump is made, a message will be 
displayed on the status line informing you that the mark was 
found.
I Italics This key performs the same function that the F6 
(bold key) did, except that this key invokes italics appearance 
instead of bold.  You will know when Italics is on, when it is 
off, and when blocked text is put into Italics.
N Normal This key resets the document into a normal 
attribute.  When this key is pressed, you will be told when the 
normal attribute has been set.
Q Mark Set This key sets a quickmark.  You will be told when 
the mark is set.  Use the control-F key sequence to jump to the 
mark.
R Repeat It took me a while to figure out where this 
function went in 6.0.  I used the ESCAPE key repeatedly (no pun 
intended) in 5.1 and was not sure where it went.   When this key 
is invoked, the screen is cleared and the "Repeat" dialog is 
invoked.  A message on the status line shows when the dialog is 
being opened or closed.
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CHART 6 (CONTINUED)

Key Meaning Description

S Play
Sound This key invokes the "Play Sound Clip" dialog.  
The screen is cleared and a message informing you that the 
dialog is being invoked is presented.  Once the dialog is 
dismissed a message is displayed informing you that you have
returned to the main document screen.

U Underline This key is the equivalent of pressing the F8 key.
Refer to chart 1 for more information.
V Paste This key pastes what you have cut using the 
control-X key sequence.  You will be notified when the text is 
pasted into the document.  The message is surrounded by caret 
symbols.

W WP CHARS This key invokes the WordPerfect characters 
dialog. The screen is cleared and a message is placed on the 
status line informing you that the dialog is being invoked.  When
you exit this dialog, a message will tell you when you have 
reached the editing screen.

X Cut This key cuts the blocked text from the document. 
A message is placed on the status line that lets you know that 
the cut has taken place.

INS TYPEOVER This key toggles the TYPEOVER feature on and off. 
A message on the status line will be shown informing you of the 
status of TYPEOVER.  This message is surrounded by caret symbols 
(^).
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Contacting the Author

I can be contacted via the following methods:

1. You can call me at (602) 888-1456.  Keep in mind that I
normally get home after 6 MST.  DO NOT call after 10:00PM.  
You will experience the wrath of Keri (my wife <GRIN>) if 
you do.  DO NOT call during the day (8AM to 6 PM - Monday 
through Friday).  I can not return calls then and would 
appreciate it if you could call during evening hours.  The 
weekend is just fine to call.

2. You can contact me via snail mail (the US post office).
My address is:

Jeff Bishop
420 E Yavapai RD.
Apartment Number H
Tucson, AZ 85705

3. I monitor Blink Talk on FIDONET.  You can ask questions
there if you would like.  Make sure that you address the 
message to "Jeff Bishop".

4. For those of you with NETMAIL capability, you can send 
mail to FIDONET node number 1:300/205 during ZMH only.  
5. You can always FREQ the latest version of this software
from FIDONET node number 1:300/204.  This system is 
available 24 hours and has a 16.8 v32BIS dual standard on-
line.  Use the magic name WPBASIK to FREQ the file.
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Conclusion

That is it!  You are now ready to run with WordPerfect 6.0. 
Additional refinements will be needed for complex screens in
WordPerfect (such as spell check).  I will be providing 
additional feedback on what should be done to configure 
these screens when firm details are available.

Expect a newer version of the keyboard file soon.  The next 
release will have menus specifically developed for blind 
users.  All functionality will be maintained, but they will 
be in an even easier structure than you see now.

Any suggestions, improvements, corrections, or any other 
comments you would like to pass on, please do.  I love 
feedback.

Happy computing, and remember to be patient with WordPerfect
6.0.  Any new product will cause some frustrations.


